# Contents

## Overview of Online Express Bill Pay
- Where do I find Online Express Bill Pay? ................................................................. 4
- How does Online Express Bill Pay update? ................................................................. 5
- Where do I learn more about Online Express Bill Pay? ............................................. 6

## Set Up Online Express Bill Pay ......................................................................... 7
- Online Express Bill Pay Security Rights .................................................................. 7
- Sign Up for Online Express Bill Pay ......................................................................... 7

## Design a Bill Payment Form ............................................................................. 10
- Get Started Tab ........................................................................................................ 10
- Layout Tab ............................................................................................................... 11
- Content Tab ............................................................................................................ 13
- Acknowledgments Tab ............................................................................................ 14
- Process Preview Tab ............................................................................................... 15

## Pay Student Bills in NetClassroom ................................................................. 16
- Bill Payment Location in NetClassroom ................................................................. 16

## Manage Transactions in Student Billing ......................................................... 18
- Security Rights to Manage Transactions ............................................................... 22
Overview of Online Express Bill Pay

Blackbaud Online Express Bill Pay enables you to set up a bill payment form, accept payments on your NetClassroom website, and then manage those transactions in Student Billing. Bill Pay works hand in hand with your existing NetClassroom setup.

Show Me: Online Express Bill Pay Overview video

To use the new Bill Pay module, you need:

- *The Education Edge* or *Blackbaud Student Information System 7.85* or higher
- Microsoft .Net Framework version 3.5 or higher
- NetClassroom

Before you get started, consider the following:

- **Who will have access to Online Express Bill Pay?**
  You need to grant access to the Online Express Bill Pay module but also to handle the financial transactions after bill payments are downloaded to Student Billing.

- **What information and instructions are important to add to your bill payment form?**
  You have the ability to customize the bill payment form with your own field labels, instructions, headings, and more.

- **What is your bank account information?**
  Determine in advance which account you want to deposit payments from student bills paid online. When you set up your Blackbaud Merchant Services bank account information, you can only configure settings for one account for the Online Express Bill Pay form.

**Where do I find Online Express Bill Pay?**

To open Online Express Bill Pay in Student Billing, on the navigation bar, click the Online Express Bill Pay link at the bottom.

When you first update your software and navigate to Blackbaud Online Express Bill Pay, the sign up page appears.
After you set up bill pay, the next time you navigate to Online Express Bill Pay, the full Online Express Bill Pay page appears.

How does Online Express Bill Pay update?
Periodically, you may be prompted to update your Online Express Bill Pay feature. It's easy to do and doesn't take much time. You'll receive a notice that improvements have been made to Bill Pay, click the Restart Now button and the software will install the update and restart the program for you.
Then, navigate back to *Online Express Bill Pay* and you're good to go!

**Where do I learn more about Online Express Bill Pay?**

- Set Up Online Express Bill Pay on page 7
- Design a Bill Payment Form on page 10
- Pay Student Bills in NetClassroom on page 16
- Manage Transactions in Student Billing on page 18
Set Up Online Express Bill Pay

To set up Bill Pay, you need to grant security rights to Online Express Bill Pay and sign up for the feature.

Online Express Bill Pay Security Rights

Before you set up security rights, determine who in your organization will need permission to edit the bill pay form. For users who will manage transactions, they will need additional security rights. For more information, see Security Rights to Manage Transactions on page 22.

Set up security rights

1. To grant access to Online Express Bill Pay, in Registrar's Office, Administration, click Set up system security.
2. Open the group you want to give access.
4. On the right, under Student Billing Privileges, select Online Bill Pay.
5. Click Save and Close.

Sign Up for Online Express Bill Pay

To use Bill Pay, you need to sign up for Blackbaud Payment Service, Blackbaud Merchant Services, and agree to the Blackbaud Online Express Bill Pay terms. Blackbaud Payment Service safely collects and stores credit and debit card information from your NetClassroom payers. Blackbaud Merchant Services is your secure payment
processor. And, Online Express Bill Pay enables you to set up bill pay forms for NetClassroom and download your transactions to Student Billing.

The first time you access the Online Express Bill Pay page, you see the option to sign up for Blackbaud Online Express Bill Pay.

Tip: If you already have Blackbaud Payment Service and Merchant Services accounts, do not set up new ones. Enter your existing credentials as you progress through the sign up process.

How to Register for Online Express Bill Pay

1. To begin the Online Express Bill Pay set up, click Register now. The Get started screen appears.

2. Enter your organization's Blackbaud Site ID number and the email address of your primary contact on your Blackbaud Support account. For example, your primary contact may be your school IT administrator.

3. Click Next. The Welcome to Blackbaud Online Express Bill Pay page appears.

4. Click Next again. The Blackbaud Payment Service screen appears.

5. To set up your Blackbaud Payment Service account, choose a user name and password for the account and agree to the terms of service.

To review the Blackbaud Payment Service terms of service, click the words terms of service.

6. Click Next. You return to the Welcome to Blackbaud Online Express Bill Pay page.
7. Click **Next** again. The Blackbaud Merchant Services screen appears.

8. To set up your Blackbaud **Merchant Services** account, choose a user name and password for the account and agree to the terms of service.

   **Note:** You can choose different or the same user names and passwords for your **Payment Service** and **Merchant Services** accounts.

9. Click **Next**. A page appears for you to enter your bank information.

10. Enter the bank account information for which you want online bill payment funds to deposit money after Blackbaud **Merchant Services** processes the transactions.

11. Click **Next**. You return to the Welcome to Blackbaud Online Express Bill Pay page.

12. Click **Next** again. The Blackbaud Online Express Bill Pay page appears for you to review the **Online Express Bill Pay** terms of service.

13. Select **I agree to the terms of service** and click **Next**. You return to the Welcome to Blackbaud Online Express Bill Pay page.

14. Click **Done**. You return to the Online Express Bill Pay sign up page. You are ready to set up your **Bill Pay** form.
Design a Bill Payment Form

To design your online bill payment form, from the Online Express Bill Pay Sign Up page, click Get started.

Also, if you want to edit, update, or improve your form, you can return to the form and make your necessary changes as needed. From the Online Express Bill Pay page, click Edit form.

The Bill Pay Form Setup screen appears. To create your online student bill payment form, review the Bill Pay Form Setup tabs.

Get Started Tab

On the Get started tab, you select the Blackbaud Merchant account you want to use to securely process transactions. You can only use one merchant account configuration for the form. Then, under Enter NetClassroom Link, enter or paste your school's NetClassroom link. The link you enter here is used to show you a preview of your form on the Process preview tab and in NetClassroom for the Blackbaud Secure Payments page.
After you enter the link, click **Save template**. The program will verify that the link is correct. If the link cannot be verified an error message will appear. If the link verifies, a **Remove template** button appears. If you need to update your *NetClassroom* link, click **Remove template**, and enter your updated *NetClassroom* link.

At the top of the Bill Pay Form Setup screen, click **Layout** to move to the Layout Tab.

**Show Me:** [Bill Pay Form Setup - Get Started Tab video](#)

**Layout Tab**

On the Layout tab, you select the layout options for your bill payment form. The tab is composed of two parts. First, you select the sections that appear on the bill payment form and then you determine the payment amount and convenience fee options.

**How to set up the bill pay form layout options**

1. **Under Which sections do you want to display on your form?** select the instructions and payment sections you want to appear on the form.

   For the instructions checkboxes you select, you enter the instructional text that you want to appear on the Content tab.
Tip: Because the payment options are required, the Payment Amount checkbox is selected for you.

2. Under Which payment amount option do you want to display?, decide if you want to enable student relations and/or students to pay only the amount due or a partial amount.

   Tip: Payers can review their billing statement in NetClassroom for the amount due before they enter how much they want to pay on the bill pay form. The payment fields on the bill pay form in NetClassroom do not automatically populate billing information.

3. Then, you select if you want to have a comment box on the form and if yes, if the comment is required.

4. For the Make a comment box a required field, if you allow student relations to choose between paying the amount due or an amount they choose, you can select to have the comment box appear Always or only for when they pay a partial amount.

5. Under Which payment methods do you want to allow payers to use?, you decide if you want to enable student relations to pay the student bill by online check only, credit card only, or if you will allow both.

6. For online checks and credit cards, you can choose to set up a convenience fee. A convenience fee is a charge for the privilege of paying the bill online. For example, you can set up a fee to help offset the cost of your merchant fees.

   Warning: Before you set up your convenience fees, we recommend you check the laws in your state to confirm what you can and cannot charge for convenience fees. For example, some states do not allow a convenience fee for only one type of online payment.

7. Under What amount do you want to charge for the convenience fee?, you can select to charge a flat rate or percentage of the payment amount due. Then, enter the amount or percentage for the fee.

   Tip: You will only see both the online check and credit card boxes if you allow payers to use both. If you do allow both, you will also see the option to charge no convenience fee for either credit cards or online checks.

Note: The convenience fee you charge payers is downloaded to Student Billing when you manage transactions but is not recorded on the student or payer's record in Student Billing. Instead, on the payment record in Student Billing you can see the convenience fee on the Attributes/Notes tab. Also, on
the Online Express Bill Pay page, you can review a summary of convenience fees from recent deposits. However, if you set up **Student Billing** as student centric, for the payer, one convenience fee is charged for the entire transaction. When you manage transactions in **Student Billing** from Online Express Bill Pay and create payments, the entire convenience fee appears for each student’s payment record, on the Attributes/Notes tab. Therefore, if you run a query of all convenience fees by the Attributes/Notes tab of payment records, you will not receive an accurate convenience fee total. Instead, use the Online Express Bill Pay page to see an accurate summary of total convenience fees.

8. At the top of the Bill Pay Form Setup screen, click **Content** to move to the Content Tab.

**Show Me:** Bill Pay Form Setup - Layout Tab video

### Content Tab

On the Content tab, you enter your heading, field, and language choices for the bill payment form.

![Content Tab](image)

The tab is composed of three sections. The top section enables you to edit how the content on the Payment Amount page appears. The middle section enables you to edit the message that appears when users in NetClassroom view the convenience fee help icon. Then, the bottom section enables you to edit the content that appears at the top of the Secure Payment page.

For the Payment Amount page, you should see the options you selected on the Layout tab. Did you select a convenience fee? Or, did you select to have any additional instructions at the top or bottom of the form? For each section, you decide how you want to word the instructions and fields on your form.

To edit fields, labels, and instructions, hover your mouse over the form. Notice how the mouse arrow changes to a hand? Every location your mouse changes to a hand, click the text. A screen appears for you to edit the language or enter new information. After you customize the wording, click **Apply**. You return to the Content tab and the text you just entered appears on the form instead of the default text.

When you are satisfied with the wording for the Payment Amount Page, review the language for the convenience fee help icon and the Secure Payment Page.

The Secure Payment page is where users enter their payment information such as their credit card number and email address. We put in default language for you to remind payers that if they change payment information, it does not automatically update their record in **Student Billing**. If necessary, adjust the information.
The choice is up to you, the Content tab is designed to help you customize the bill payment form towards your school's specific language and instruction needs.

At the top of the Bill Pay Form Setup screen, click **Acknowledgments** to move to the Acknowledgments Tab.

**Show Me:** Bill Pay Form Setup - Content Tab video

### Acknowledgments Tab

On the Acknowledgments tab, you create a customized acknowledgment email and confirmation screen for payers after payments are submitted in *NetClassroom*.

First, you edit the email message. To edit the message, under **Edit the email message to send to acknowledge payments**, a preview appears for the default email message. Select **click to edit email**. The box changes to an editable email message.

Enter the **Subject**, **From address**, and **From name** for the email. Then, you can edit the default text in the body of the email. Use the toolbar options to format the body of the email as necessary. For example, you can highlight text, change fonts, and create bullet lists.

On the toolbar, click **Insert**. On the Insert tab, you can enter links, special characters, and merge fields for the email message. Merge fields customize the email message for each payer with **Student Billing** record information and information the payer entered on the bill payment form.

To include payment and student fields, click the **Merge fields** button. A screen appears.

**Tip:** For the **Payment Fields**, the payer information is based on the user who logged into *NetClassroom*.

Drag and drop or double-click a merge field to add it to the email message. You can also select and move the merge field after you add it to the email message as well as select and delete to remove.

**Warning:** We do not recommend you use two student merge fields together. For parents with more than one student, if you choose two student merge fields, the names will not appear correctly on the email message. The merged information inserts as a comma-separated list.
After you insert merge fields, you can toggle back and forth between the Formatting and Insert tabs to help design your message as necessary.

After you set up your acknowledgment email confirmation, you can edit the default message for the confirmation screen that payers see in *NetClassroom* after they submit the online bill payment. Under **Edit the confirmation screen to display after payments are made**, select **click to edit confirmation**. For the confirmation screen, the toolbar options are the same as the payment confirmation email message except that you do not have the **Subject** and **From** fields.

When you complete the design of your confirmation screen and are satisfied with both of your acknowledgments, click **Process preview** to move to the Process Preview Tab.

**Show Me:**  Bill Pay Form Setup - Acknowledgments Tab video

### Process Preview Tab

On the Process preview tab, you review the selections and formatting you chose for the online student bill payment form.

![Process Preview Tab](image)

You cannot make any edits on this tab. Instead, you review the choices you made on each tab of the Bill Pay Form Setup screen to confirm your bill pay form is correct.

If your school uses a mixed payer centric and student centric system, use the **Show for** field to switch between the two billing set ups. For each, you can confirm how the payment information displays.

**Tip:** On this tab, you should see your *NetClassroom* design as part of the process preview. If you do not, go back to the **Get started** tab and enter your *NetClassroom* link.

Then, switch between the **Payment Amount**, **Payment Details**, and **Confirmation** pages to review the form. If needed, to make changes to your selections, go back to the tabs that you need to update.

When you are ready to use your form, click **Done** or if you are editing a previously set up form, click **Save and Close**.

**Show Me:**  Bill Pay Form Setup - Process Preview Tab video
Pay Student Bills in NetClassroom

When you are ready for NetClassroom users to pay student bills online, you grant them access in Registrar's Office. Before you grant access, decide if student relations, students, or both will be allowed to pay student bills online.

How to grant payer access to the Online Express Bill Pay form in NetClassroom

1. In Registrar's Office, from the Configuration page, click NetClassroom. The NetClassroom page appears.
2. From the list on the left, select Features.
3. Select whether to set the features for all schools in your organization, or select a school to set features for in the Settings below apply to field.

If you select to set features by school, complete procedure step four for each school in your organization.
4. In the Features available for relations box, to enable student relations to pay student bills online, select Bill Pay. In the Features available for students box, to enable students to pay student bills online, select Bill Pay.

5. When you leave the Features page, your settings are saved automatically.

Bill Payment Location in NetClassroom

Now, when student relations and/or students log in to NetClassroom, they can find the bill payment option under Billing in the menu.
As an additional help for you, on the Online Express Bill Pay How-to Documentation page, you can find an editable quick tip Microsoft Word document for payers.

You are now ready to receive bill payments online for student bills.
Manage Transactions in Student Billing

After payers submit the student bill payment, in Student Billing, payments waiting to be downloaded and processed in Student Billing appear in the upper left corner.

Show Me: To watch a video about how to manage transactions, see the Manage Transactions in Online Express Bill Pay video.

When you manage transactions, you download them from Student Billing, add transactions to new or existing deposits, and then create payments with Fast!

Tip: To refresh and get latest transactions more quickly, in the navigation bar, click the Online Express Bill Pay link again.

Manage Transactions

If you are unable to see and process transactions, you may need to review your security settings. In addition to security rights to Online Express Bill Pay, users who need to manage bill payment transactions need additional security rights.

1. From the Online Express Bill Pay page, click Manage Transactions. The Manage Online Express Bill Pay Transactions screen appears and opens to the Add to Deposit(s) and Process tab.
2. Under Filters, you can filter the list of transactions that appear under Undeposited Transactions Table, by date and by payment method.

Tip: As a recommendation of when to add transactions to a deposit, some schools choose to use their settlement report and bank statements to see what has already been dispersed before they create deposits and run Fast!

3. To create a new deposit or add to an existing deposit, under Undeposited Transactions Table, select the transactions to group together.

Note: For student centric records, a transaction for multiple students is split into one per student. However, because the records must be processed together, if you select one student's transaction and add to a deposit, the other students’ transactions are also added to the deposit.

As you select transactions, under Summary of Selected Transactions, review a total of your grouping.

4. After you select transactions, click Add selected to New Deposit or Add selected to Existing Deposit.
If you add to an existing deposit, search for and open the existing deposit. The deposit then moves under the **List of Deposits to Process** and the transactions no longer appear under **Undeposited Transactions Table**.

If you add to a new deposit, the Add a New Deposit screen appears. You can edit information about the deposit before you **Save and Close**. When you **Save and Close**, the deposit then moves under the **List of Deposits to Process** and the transactions no longer appear under **Undeposited Transactions Table**.

**Tip**: You have not processed the transactions yet so you can review your deposits again before you create payments with Fast! Also, if you do click **Continue to Fast!**, you have an opportunity to review a read-only version of the deposit before you commit records.

5. Under **List of Deposits to Process**, double-click the deposit to review the included transactions. The Included Transactions screen appears.
If needed, you can remove transactions from the deposit. To remove transactions, select the transactions that you do not want in the deposit and click **Remove selected payments from the deposit.** The transaction returns to the list of undeposited transactions.

6. If you forgot to add a transaction to a deposit, select an undeposited transaction and under **List of Deposits to Process,** in the row of the deposit in which you want to add the transaction, click **Add to this Deposit.**

7. When ready to create payments with **Fast!,** click **Continue to Fast!** The Fast screen appears.

8. Enter a name and description. Then, on the Datasheet tab, review the list of payments to be created in the deposit.

   **Warning:** If you want to edit details about the deposit or transactions, you do not edit them in **Fast!** Close this window before you commit records, and return to the Manage Online Express Bill Pay transactions screen to make the necessary changes.

9. To run **Fast!,** click the **Commit Records.**

10. To confirm, click **Yes.** The Save Static Query screen appears.

   If you want to save a query of your **Fast!** results, enter the query information and click **Save.** Otherwise, click **Cancel.**

11. The Commit Records screen appears and the records process.

    When complete, the Commit records screen appears with your results. Click **Continue.** You return to the Manage Online Express Bill Pay Transactions screen and opens to the Review Committed Payments tab.
On the Review Committed Payments tab, each payment created appears as a separate row.

**Tip:** If the payer included a comment about the student bill payment, you can review the comment in the Payer Notes column.

To review the payment record for the online bill payment transaction, double-click a payment or select the payment and click **Open**. You can make adjustments as needed. For example, on the Student Billing Detail tab, you may want to add or edit applications.

13. Click **Save and Close** to return to the Manage Online Express Bill Pay Transactions screen.

Click **Done**. You return to the Online Express Bill Pay page and under the **History of manage transactions**, the deposits you just committed are added to the Recently committed deposits table.

**Show Me:** For more information about how to review recently committed deposits, see the **Recently Committed Deposits video**.

### Security Rights to Manage Transactions

Users who need to manage bill payment transactions need security rights to Online Express Bill Pay and security rights to see and process the transaction with **Fast!**. In **Administration**, **Set up system security**, for those users who will manage transactions, at minimum, provide the following security rights:
<table>
<thead>
<tr>
<th>System Components</th>
<th>Privileges</th>
<th>Security Options</th>
<th>Additional Security Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student Billing</td>
<td>Bill Pay</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Student Billing</td>
<td>Records</td>
<td>Payments</td>
<td>Payments [Edit], Payments</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Adjustments [View], and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Payments Attributes/Notes [Edit]</td>
</tr>
<tr>
<td>Student Billing</td>
<td>Records</td>
<td>Deposits</td>
<td>[Add]</td>
</tr>
<tr>
<td>Student Billing</td>
<td>Records</td>
<td>Student</td>
<td>[View]</td>
</tr>
<tr>
<td>Student Billing</td>
<td>Records</td>
<td>Application</td>
<td>[Edit]</td>
</tr>
<tr>
<td>Shared Components</td>
<td>Fast!</td>
<td>Design, Datasheet</td>
<td>[All Rights]</td>
</tr>
<tr>
<td>Shared Components</td>
<td>Bank Accounts</td>
<td>Bank Account List</td>
<td>[View] for each bank account to appear for deposits.</td>
</tr>
</tbody>
</table>

23 • Chapter 3